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Applying a fix pack

The instructions to apply a fix pack or interim fix on IBM MobileFirst™ Platform
Foundation for iOS V7.1.0 are provided in the following two main tasks:
v “Running IBM Installation Manager” on page 2-1
v “Updating the application server” on page 3-1 by one of the following ways:

– With Server Configuration Tool

Note: Only for MobileFirst Server applications. Not for Application Center,
MobileFirst Operational Analytics, and MobileFirst Data Proxy.

– With Ant tasks
– Manually
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Running IBM Installation Manager

About this task

First, run Installation Manager to update the binary files of IBM MobileFirst
Platform Foundation for iOS on your disk. Then, update the MobileFirst Server
components on your application server by following the steps that are described in
“Updating the application server” on page 3-1.

Installation Manager can be run in two ways: by graphical user interface (GUI), or
by command-line. The effect of running Installation Manager to apply a fix pack
depends on the choice that you made at the initial installation.

If Application Center is installed at the initial installation and deployed to an
application server, Installation Manager updates Application Center in the
application server when you apply the fix pack. If Installation Manager fails to find
Application Center on the application server (such Application Center WAR file is
removed), the update fails, and Installation Manager fails to apply the fix pack.

If Application Center is not installed at the initial installation and deployed to an
application server, Installation Manager updates only the binary files on your disk.
This operation usually does not fail unless an error occurs during the updating of
the files. For example, on Windows environment, you run a process (such as Ant
task or Server Configuration Tool) inside the MobileFirst installation directory
while you apply the update.

Tip: To determine whether Application Center is installed with Installation
Manager, you can check the registry of Installation Manager.
v If you run Installation Manager in GUI mode, the choice is displayed in the

wizard pane when you are at the Configuration Choice panel.
v If you do not run Installation Manager in GUI mode, you can look at the content

of the product_install_dir/shortcuts/application-center.sh file.
– If it contains the line

url=’${appserver.root.url}${appserver.appcenter.console.path}’, it means
that Application Center is not installed by Installation Manager.

– If it contains a URL that is defined (such as url=’http://localhost:9080/
appcenterconsole/’), it means that Application Center is installed by
Installation Manager.

Running Installation Manager in graphical mode
Procedure
1. Run Installation Manager from the user account that is used at the initial

installation.
To apply an update, Installation Manager must run with the same list of
registry files that are used at the initial installation. The list of Software that is
installed and the options that are used during the installation time are stored in
those registry files. If you run Installation Manager in administrator mode, the
registry files are installed at the system level. In /var folder on UNIX or Linux.
In c:\ProgramData folder on Windows. The location is independent from the
user who runs Installation Manager (although root is needed on UNIX and
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Linux). However, if you run Installation Manager in single user mode, the
registry files are stored by default in the user's home directory.

2. Select File > Preferences.
Enter the repository of IBM MobileFirst Platform Foundation for iOS V7.1.0 and
also the repository of the fix pack if you plan to make a fresh installation of
V7.1.0 with a fix pack or interim fix. The fix packs are delivered as delta
installers and cannot be installed if the base version is not among the listed
repositories.
For example, if you decompress the base installer in 710_installer_directory
folder, the repository file to enter is 710_installer_directory/
MobileFirst_Platform_Server/disk1/diskTag.inf. If you decompress the
interim fix file in ifix_directory folder, the repository file to enter is
ifix_directory/MobileFirst_Platform_Server/disk1/diskTag.inf.
If you plan to update an existing IBM MobileFirst Platform Foundation for iOS
V7.1.0 (apply a fix pack or interim fix), the repository of product is not needed.

3. After the repositories are entered, click OK to close the Preferences display.
4. Click Update and select the package that you need to update. Installation

Manager displays a list of packages. By default, the package to update is
named as IBM MobileFirst Platform Server. The name might change due to
the following scenarios:
v If you have multiple installations of IBM MobileFirst Platform Server, a

suffix might be appended to the package name. For example, IBM
MobileFirst Platform Server_2.

v If you install the product with a version earlier than V6.3.0, the package
name uses the name of the product for that version. For example, IBM
Worklight for the product name that is installed for V6.2.0, and then
upgraded to V7.1.0.

v If the package is not in the list, the cause might be that you did not run
Installation Manager with the same user account that was used at the initial
installation. Either find the user account that was used to run Installation
Manager, or make a fresh installation of the product and the interim fix by
clicking Install instead of Update.
– If you need to make a fresh installation, but Application Center is already

installed with Installation Manager, the procedure does not update
Application Center in the application server.

– If Application Center is installed with Installation Manager, but the
package is not found when you click Update, then you have to update
Application Center manually.

5. Accept the license terms, and click Next. You might have to determine whether
you need to activate token licensing or not. Token Licensing is a new feature
that is introduced with an interim fix released on 15 September 2015 or later.
v If you do not have a contract to use token licensing with the Rational®

License Key Server, click Do not activate token licensing.
v If you activate token licensing, make sure that the Rational License Key

Server is configured, and enough tokens can be obtained to run MobileFirst
Server and the applications it serves. Otherwise, the MobileFirst Server
administration application and the runtime environments cannot be run.

All choices are disabled in the panes, excepted some passwords (databases and
server administrator) that you can update if they are modified since the last
installation.

6. In the Thank You panel, click Next. A summary is displayed.
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7. Click Update to start the update procedure.

What to do next

“Updating the application server” on page 3-1

Running Installation Manager in command-line mode
Procedure
1. Download the silent install files from http://public.dhe.ibm.com/software/

products/en/MobileFirstPlatform/docs/v710/Silent_Install_Sample_Files.zip.
2. Decompress the file, and select 7.1/upgrade-initially-mfpserver.xml file.
v If you initially installed the product in V6.0.0, V6.1.0 or V6.2.0, select the

7.1/upgrade-initially-worklightv6.xmlfile instead.
v If you initially installed the product in V5.x, select this 7.1/upgrade-

initially-worklightv5.xml file instead.

The file contains the profile identity of the product. The default value of this
identity changes over the releases of the product. In V5.x, it is Worklight. In
V6.0.0, V6.1.0, and V6.2.0, it is IBM Worklight. In V6.3.0, V7.0.0, and V7.1.0, it is
IBM MobileFirst Platform Server.

3. Make a copy of the file you selected.
4. Open the copied XML file with a text editor or XML editor. Modify the

following elements:
a. The repository element that defines the repository list.

Create a repository entry for the repository of IBM MobileFirst Platform
Foundation for iOS V7.1.0 and also the repository of the fix pack if you plan
to make a fresh installation of V7.1.0 with a fix pack or interim fix. The fix
packs are delivered as delta installers and cannot be installed if the base
version is not among the listed repositories.
For example, if you decompress the base installer in
710_installer_directory folder, the repository file to enter is
710_installer_directory/MobileFirst_Platform_Server/disk1/
diskTag.inf. If you decompress the interim fix file in ifix_directory folder,
the repository file to enter is ifix_directory/
MobileFirst_Platform_Server/disk1/diskTag.inf.
If you plan to update an existing IBM MobileFirst Platform Foundation for
iOS V7.1.0 (apply a fix pack or interim fix), the repository of product is not
needed.

b. Optional: Update the passwords for the database and the application server.
If Application Center is installed at the initial installation with Installation
Manager, and the passwords for the database or the application server are
changed, you can modify the value in the XML file. These passwords are
used to validate that the database has the right schema version, and to
upgrade it if it is in a version older than V7.1.0. They are also used to run
wsadmin for an installation of Application Center on WebSphere®

Application Server full profile. Uncomment the appropriate lines in the
XML file:
<!-- Optional: If the password of the WAS administrator has changed-->
<!-- <data key=’user.appserver.was.admin.password2’ value=’password’/> -->
<!-- Optional: If the password used to access the DB2 database for

Application Center has changed, you may specify it here-->
<!-- <data key=’user.database.db2.appcenter.password’ value=’password’/> -->
<!-- Optional: If the password used to access the MySQL database for
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Application Center has changed, you may specify it here -->
<!-- <data key=’user.database.mysql.appcenter.password’ value=’password’/> -->
<!-- Optional: If the password used to access the Oracle database for

Application Center has changed, you may specify it here -->
<!-- <data key=’user.database.oracle.appcenter.password’ value=’password’/> -->

c. If you have not made a choice before to activate token licensing that is
released with an interim fix on 15 September 2015 or later, uncomment the
line <data key=’user.licensed.by.tokens’ value=’false’/>. Set the value
to true if you have a contract to use token licensing with the Rational
License Key Server. Otherwise, set the value to false.
If you activate token licensing, make sure that the Rational License Key
Server is configured, and enough tokens can be obtained to run MobileFirst
Server and the applications it serves. Otherwise, the MobileFirst Server
administration application and the runtime environment cannot be run.

Restriction: After the decision is made to activate token licensing or not, it
cannot be modified. If you run an upgrade with the value true, and later
another upgrade with the value false, the second upgrade fails.

d. Review the profile identity and the installation location. The profile identity
and the installation location must match what is installed:
v This line: <profile id=’IBM MobileFirst Platform Server’

installLocation=’/opt/IBM/MobileFirst_Platform_Server’>

v And this line: <offering id=’com.ibm.mobilefirst.foundation.server’
version=’7.1.0.00-20150913-2345’ profile=’IBM MobileFirst Platform
Server’ features=’main.feature’ installFixes=’none’/>

v To review the profile identity and the installation directories that are
known to Installation Manager, you can type the command:
installation_manager_path/eclipse/tools/imcl listInstallationDirectories -verbose

e. Update the version attribute to and set it to the version of the interim fix.
For example, if you install the interim fix (7.1.0.0-IF201510051721), replace
<offering id=’com.ibm.mobilefirst.foundation.server’
version=’7.1.0.00-20150913-2345’ profile=’IBM MobileFirst Platform
Server’ features=’main.feature’ installFixes=’none’/> by <offering
id=’com.ibm.mobilefirst.foundation.server’ version=’7.1.0.00-
20151005-1721’ profile=’IBM MobileFirst Platform Server’
features=’main.feature’ installFixes=’none’/>. Installation Manager
does not only use the repositories that are listed in the installation file, but
also the repositories that are installed in its preferences. Specifying the
version attribute in the offering element is optional. However, by
specifying it, you ensure that the interim fix that is defined is the version
that you intend to install. This specification overrides the other repositories
with interim fixes that are listed in the Installation Manager preferences.

Note: For V6.3.0 or earlier, the version number is not the same as the
interim fix number. You can find the version number in
ifix_directory/MobileFirst_Platform_Server/disk1/md/repository.xml
file, in the line <offering id=.... version=’6.2.0.00-20141005-1729’>.

5. Open a session with the user account that is used at the initial installation.
To apply an update, Installation Manager must run with the same list of
registry files that are used at the initial installation. The list of Software that is
installed and the options that are used during the installation time are stored in
those registry files. If you run Installation Manager in administrator mode, the
registry files are installed at the system level. In /var folder on UNIX or Linux.
In c:\ProgramData folder on Windows. The location is independent from the

2-4 IBM MobileFirst Platform Foundation for iOS V7.1.0: Applying a fix pack for MobileFirst Server V7.1.0



user who runs Installation Manager (although root is needed on UNIX and
Linux). However, if you run Installation Manager in single user mode, the
registry files are stored by default in the user's home directory.

6. Run the command installation_manager_path/eclipse/tools/imcl input
<responseFile> -log /tmp/installwl.log -acceptLicense

Where
v <responseFile> is the XML file that you edit in 4 on page 2-3.
v -log /tmp/installwl.log is optional. It specifies a log file for the output of

Installation Manager.
v -acceptLicense is mandatory. It means that you accept the license terms of

IBM MobileFirst Platform Foundation for iOS V7.1.0. Without that option,
Installation Manager cannot proceed with the update.

What to do next

“Updating the application server” on page 3-1
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Updating the application server

About this task

IBM MobileFirst Platform Foundation for iOS provides several components that
you might have installed. Here is a description of their dependencies to update
them:

MobileFirst Server Administration Service, MobileFirst Operations Console, and
MobileFirst runtime environment

These three components compose as MobileFirst Server. They must be
updated together. In particular, the MobileFirst Server Administration
Service and the runtime environment communicate through a JMX API
that must be at the same level between those components. The runtime
environment might fail to start due to the binary incompatibilities between
the JMX API in the Administration Service and the runtime environment.

Although the runtime is provided by your development team and built
with MobileFirst Platform Command Line Interface for iOS (CLI), you need
to update it when you apply a fix pack. This is because the runtime
environment is installed together with a shared Java™ library
(worklight-jee-library.jar) that might contain fixes. However, it is not
needed to apply an interim fix to CLI to update the runtime environment.
For more information about migrating the project WAR file so that it is
binary compatible with the worklight-jee-library.jar library, see
“Updating MobileFirst Server Administration Service, MobileFirst
Operations Console, and MobileFirst runtime environment.”

Application Center
The installation of this component is optional. This component is
independent of the other components. It can be run at a different interim
fix level than the others if needed.

MobileFirst Operational Analytics
The installation of this component is optional. The MobileFirst components
send data to MobileFirst Operational Analytics via a REST API. It is
preferable to run MobileFirst Operational Analytics with the other
components of MobileFirst Server of the same interim fix level.

MobileFirst Data Proxy and the MobileFirst OAuth Trust Association Interceptor
(TAI) The installation of these components is optional. These components

communicate with the runtime environment to get and authenticate the
OAuth tokens. It is preferable to run these components with the other
components of MobileFirst Server of the same interim fix level.

Updating MobileFirst Server Administration Service, MobileFirst
Operations Console, and MobileFirst runtime environment

About this task

You can update these components in three ways:
v With Server Configuration Tool
v With Ant tasks
v Manually

© Copyright IBM Corp. 2015 3-1



The updating procedure depends on the method you used at the initial installation.

The product is installed with Server Configuration Tool

v You can apply the fix pack with Server Configuration Tool.
v You can apply the fix pack with Ant tasks. Server Configuration Tool can

export the Ant files of a configuration by using File > Export
Configuration as Ant files.... When you select this option, you are
prompted to select a directory. A subdirectory that is named after the
name of the configuration is created in the directory you selected. An
Ant file for the Administration Service is saved in this subdirectory. One
subdirectory per runtime environment is also created in this
configuration directory. It is named after the name of the runtime in the
configuration. An Ant file for this runtime is also saved in the
subdirectory.

v You can apply the fix pack manually.

The product is installed with Ant tasks

v You can apply the fix pack with Ant tasks. Use the Ant tasks that are
created at the initial installation. This way, you are certain to have the
same parameters as the initial installation.

v You can apply the fix pack manually.

The product is installed manually

v You can apply the fix pack manually.
v An attempt to apply the fix pack with Ant tasks might fail. The target of

the Ant tasks to apply a fix pack assume that the installation is made in
a certain way.

You need to restart the application server after the update is completed. Applying
a fix pack not only updates the WAR files but also updates a shared library
(worklight-jee-library.jar). As a result, the application servers usually need to
be restarted for these changes to take effect.

When the application server starts, MobileFirst runtime environment (the
application that replies to the requests of mobile apps) needs some times to be
available. The MobileFirst Server Administration Service needs to be started first.
Then, the runtime environment contacts the Administration Service to synchronize
itself, get the list of adapters and applications it needs to serve. The runtime
environment can reply to the mobile apps requests only after this synchronization
is complete.

Important:

v Impact on high availability:
When you stop the runtime application or the server that runs the runtime
application, two possible behaviors might happen:
– If the runtime application is configured for session-dependent mode, all

sessions, that are connected to the server, are closed after you stop the server.
The users might need to reauthenticate. The session-dependent mode is the
default mode for the apps that are developed with V7.0.0 or earlier. To avoid
this behavior, you can consider duplicating the environment and draining the
servers before you stop the servers. For more information, see Rolling
upgrade procedure to apply a fix pack to IBM MobileFirst Platform
Foundation V7.1.0 in stateful mode.

– If the runtime application is configured for session-independent mode
(default mode for the apps that are developed with V7.1.0), there is no impact
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on the open sessions when the server stops. However, in some rare cases, the
users might experience problems with login on existing session during all the
time where the cluster or farm is in hybrid mode.

Management operations must be forbidden until all the cluster or the farm is
upgraded. Such operations can be uploading an application or a new version of
an adapter, or any operation that is performed from MobileFirst Operations
Console or wladm command.

v WebSphere Application Server specifics:
– The user that runs the upgrade needs to have at least the privileges of a

Deployer role to update the WAR files and a shared library.
– The order of operations is important. Make sure that you follow the sequence

that is described in the following sections to update the MobileFirst Server
Administration component first. Then, the runtime environments. If the
runtime environments fail to synchronize with the MobileFirst Server
Administration (such as JMX binary incompatibility that is introduced in the
fix pack), they would fail to start.

Applying the fix pack with the Server Configuration Tool
Procedure
1. Start the Server Configuration Tool from the product installation that contains

the fix pack or interim fix.
To verify that the Server Configuration Tool is the correct version, open the
menu Help > About the Server Configuration Tool. A dialog appears with the
build number. It must match the fix pack that you install with Installation
Manager. For example, make sure that the build number of the Server
Configuration Tool is 7.1.0.00.20151005-1721 if the interim fix
7.1.0.0-IF201510051721 is installed.
The Server Configuration Tool updates the application server with the WAR
files and JAR files that it finds in its installation directory. If you start the Server
Configuration Tool from a product installation that does not contain the correct
fix pack or interim fix, it will not update the application server to the right
level.

2. Select the configuration to update.
3. Select Configurations > Upgrade a Previous Configuration. A dialog opens.

a. Enter the requested passwords (database / application server).
b. Verify the path of the project WAR file (runtime path).

If the path is not to the current project WAR file produced by your
development team, update the path. This WAR file is to be migrated (to be
binary compatible with the worklight-jee-library.jar of the fix pack or
interim fix) and redeployed to the application server. The base name of the
project WAR file must be the same as the one that is previously installed.

c. Click OK.
d. The upgrade starts. The Server Configuration Tool connects to the database

to verify that they are at the right version level. If they are not at version
7.1, it upgrades them.

4. Optional: Alternative method to apply a fix pack without contacting the
database:
a. Select a configuration.

1) Select Configurations > Replace Administration Service WAR files
(use this to apply a fix pack).... The configuration wizard opens for you
to update some passwords if needed.
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2) Click OK and the configuration details panel appears.
3) Click Update WAR....

b. In the tree view, expand Runtime environments. For each runtime, do the
following steps:
1) Select the runtime in the tree view.
2) Select Runtimes > Replace project WAR File.... The runtime wizard

opens for you to update the database and application server passwords
if needed.

3) Verify the path of the project WAR file. If the path is not to the current
project WAR file produced by your development team, update the path.
This WAR file is to be migrated (to be binary compatible with the
worklight-jee-library.jar of the fix pack or interim fix) and
redeployed to the application server. The base name of the project WAR
file must be the same as the one that is previously installed.

4) Click OK and the runtime environment configuration description panel
appears.

5) Click Update WAR....
5. Restart the application server.

Applying the fix pack with Ant tasks
About this task

Run the minimal-admupdate target to update the Administration Service WAR file.
Then, run the minimal-update target to update the runtime WAR file and the
worklight-jee-library.jar library. Restart the application server for these updates
to take effect.

Procedure
1. Use the Ant files that are used at the initial installation. This way, you are

certain to have the same parameters as the initial installation.
a. Open the Ant file and verify the value of the worklight.server.install.dir

property.
Make sure that worklight.server.install.dir points to the installation of
the product that contains the interim fix. The Ant tasks update the
application server with the WAR files and JAR files that are found in this
installation directory. If the property points to an installation without the
interim fix, the update to the application server is not to the right level. To
verify that the product installation directory contains the interim fix, open
product_install_dir/README.html. This file contains the build number. For
example, if interim fix IFIX 7.1.0.0-IF201510051721 is installed, the build
number in the README.html file must contain this line: Build number: IMF
00-20151005-1721.

b. Verify the value of the worklight.project.war.file property in the Ant file.
If the path is not to the current project WAR file produced by your
development team, update the path. This WAR file is to be migrated (to be
binary compatible with the worklight-jee-library.jar of the fix pack or
interim fix) and redeployed to the application server. The base name of the
project WAR file must be the same as the one that is previously installed.

c. Verify the passwords.
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The Ant file might contain ************ as value for the passwords. You
need exactly 12 stars (************) if you want the password to be
prompted interactively (such as during the deployment on WebSphere
Application Server).
If the value is defined in the Ant file, verify that the passwords are still up
to date.

2. Run the minimal-admupdate target to update the MobileFirst Server
Administration Service and MobileFirst Operations Console WAR files. For
example,
product_install_dir/shortcuts/ant -f your_ant_file.xml minimal-admupdate

3. Run the minimal-update target to update each MobileFirst runtime. For
example,
product_install_dir/shortcuts/ant -f your_ant_file.xml minimal-update

This minimal-update target makes a copy of the project WAR file that is
specified by the property worklight.project.war.file and migrates the copy
so that it is binary compatible with the new worklight-jee-library.jar library.
It also installs this copy of the WAR file into the application server and updates
the worklight-jee-library.jar library.

4. Restart the application server for these updates to take effect.
5. Repeat this operation for all the servers of a farm.

Applying the fix pack manually
Procedure
1. Locate the WAR and JAR files of the fix pack or interim fix. The new versions

of these files that you need to update are in product_install_dir/
WorklightServer folder.

2. Replace the worklightadmin.war and worklightconsole.war files in your
application server.

Note: For WebSphere Application Server full profile, make sure that the
configured values of the JNDI properties are not erased.

3. Replace the worklight-jee-library.jar library.
4. Make sure that the project WAR file (MobileFirst runtime WAR file) is binary

compatible with the updated worklight-jee-library.jar library.
a. Find the most current version of the project WAR file that is published by

your development team.
b. Migrate the project WAR file as described in Migrating a project WAR file

for use with a new MobileFirst Server.
c. Replace the project WAR file in your application server.
d. On WebSphere Application Server Network Deployment, do a full

synchronization of the servers.
5. Restart the application servers for these updates to take effect.

Verifying the updates
Procedure
1. Log in to MobileFirst Operations Console.
2. Select the menu Hello, your_name > About on the upper right of the window.
3. Verify the version. It must match the fix pack or interim fix version that is

installed.
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For example, if the interim fix 7.1.0.0-IF201510051721 is installed, the version
displays in About must be Server version: 7.1.0.00.20151005-1721.

4. Run wladm command with show versions command to verify the version of the
worklight-jee-library.jar library. In the output, the value of productVersion
and the value of serverVersion for each runtime environment ought to
correspond to the fix pack or interim fix version. For more information about
the commands, see Administering MobileFirst applications through the
command line and Commands for troubleshooting.

Updating Application Center
About this task

You can update this component in three ways:
v With Installation Manager
v With Ant tasks
v Manually

The updating procedure depends on the method you used at the initial installation.

The component is installed with Installation Manager
Application Center is automatically upgraded when you run Installation
Manager to update your installation. There is no further action required.

The component is installed with Ant tasks

v You can apply the fix pack with Ant tasks. Use the Ant tasks that are
created at the initial installation. This way, you are certain to have the
same parameters as the initial installation.

v You can apply the fix pack manually.

The component is installed manually

v You can apply the fix pack manually.
v An attempt to apply the fix pack with Ant tasks might fail. The target of

the Ant tasks to apply a fix pack assume that the installation is made in
a certain way.

Applying the fix pack with Ant tasks
Run the minimal-update target to update the Application Center service and the
Application Center console WAR files.

Procedure
1. Use the Ant files that are used at the initial installation. This way, you are

certain to have the same parameters as the initial installation.
a. Open the Ant file and verify the value of the worklight.server.install.dir

property.
Make sure that worklight.server.install.dir points to the installation of
the product that contains the interim fix. The Ant tasks update the
application server with the WAR files and JAR files that are found in this
installation directory. If the property points to an installation without the
interim fix, the update to the application server is not to the right level. To
verify that the product installation directory contains the interim fix, open
product_install_dir/README.html. This file contains the build number. For
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example, if interim fix IFIX 7.1.0.0-IF201510051721 is installed, the build
number in the README.html file must contain this line: Build number: IMF
00-20151005-1721.

b. Verify the passwords.
The Ant file might contain ************ as value for the passwords. You
need exactly 12 stars (************) if you want the password to be
prompted interactively (such as during the deployment on WebSphere
Application Server).
If the value is defined in the Ant file, verify that the passwords are still up
to date.

2. Run the minimal-update target to update Application Center. For example,
product_install_dir/shortcuts/ant -f your_ant_file.xml minimal-update

This minimal-update target updates the WAR files of Application Center service
and the Application Center application.

3. Restart the application server for these updates to take effect.

Note: On WebSphere Application Server full profile, it is sufficient to restart
the Application Center applications.

Applying the fix pack manually
Procedure
1. Locate the Application Center WAR files. The new versions of these files that

you need to update are in product_install_dir/ApplicationCenter/console
folder.

2. Replace the appcenterconsole.war and applicationcenter.war files in your
application server.

Note: For WebSphere Application Server full profile, make sure that the
configured values of the JNDI properties are not erased.

3. On WebSphere Application Server Network Deployment, do a full
synchronization of the servers.

4. Restart the application servers for these updates to take effect.

Updating MobileFirst Operational Analytics
Before you begin

On WebSphere Application Server, applying a fix pack creates a significant peak of
memory usage in the heap. If the server has insufficient memory heap, this might
cause OutOfMemory issues, and seriously impact the performance of the application
server.

Before you perform the following procedure, verify that your server has the
memory settings that are described at Setting up a production cluster.

About this task

You can update this component in two ways:
v With Ant tasks
v Manually
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The updating procedure depends on the method you used at the initial installation.

The component is installed with Ant tasks

v You can apply the fix pack with Ant tasks. Use the Ant tasks that are
created at the initial installation. This way, you are certain to have the
same parameters as the initial installation.

v You can apply the fix pack manually.

The component is installed manually

v You can apply the fix pack manually.
v An attempt to apply the fix pack with Ant tasks might fail. The target of

the Ant tasks to apply a fix pack assume that the installation is made in
a certain way.

Applying the fix pack with Ant tasks
Run the minimal-update target to update the MobileFirst Operational Analytics
service and the MobileFirst Operational Analytics console WAR files.

Procedure
1. Use the Ant files that are used at the initial installation. This way, you are

certain to have the same parameters as the initial installation.
a. Open the Ant file and verify the value of the worklight.server.install.dir

property.
Make sure that worklight.server.install.dir points to the installation of
the product that contains the interim fix. The Ant tasks update the
application server with the WAR files and JAR files that are found in this
installation directory. If the property points to an installation without the
interim fix, the update to the application server is not to the right level. To
verify that the product installation directory contains the interim fix, open
product_install_dir/README.html. This file contains the build number. For
example, if interim fix IFIX 7.1.0.0-IF201510051721 is installed, the build
number in the README.html file must contain this line: Build number: IMF
00-20151005-1721.

b. Verify the passwords.
The Ant file might contain ************ as value for the passwords. You
need exactly 12 stars (************) if you want the password to be
prompted interactively (such as during the deployment on WebSphere
Application Server).
If the value is defined in the Ant file, verify that the passwords are still up
to date.

2. Run the minimal-update target to update MobileFirst Operational Analytics. For
example,
product_install_dir/shortcuts/ant -f your_ant_file.xml minimal-update

This minimal-update target updates the WAR files of MobileFirst Operational
Analytics service and the analytics console.

3. Restart the application server for these updates to take effect.

Note: On WebSphere Application Server Network Deployment, it is sufficient
to restart the MobileFirst Operational Analytics applications.
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Applying the fix pack manually
Procedure
1. Locate the MobileFirst Operational Analytics WAR files. The new versions of

these files that you need to update are in product_install_dir/Analytics
folder.

2. Replace the analytics-service.war and analytics-ui.war files in your
application server.

3. On WebSphere Application Server Network Deployment, synchronize the
servers.

4. Restart the application servers for these updates to take effect.

Updating MobileFirst Data Proxy
About this task

You can update this component in two ways:
v With Ant tasks
v Manually

The updating procedure depends on the method you used at the initial installation.

The component is installed with Ant tasks

v You can apply the fix pack with Ant tasks. Use the Ant tasks that are
created at the initial installation. This way, you are certain to have the
same parameters as the initial installation.

v You can apply the fix pack manually.

The component is installed manually

v You can apply the fix pack manually.
v An attempt to apply the fix pack with Ant tasks might fail. The target of

the Ant tasks to apply a fix pack assume that the installation is made in
a certain way.

Applying the fix pack with Ant tasks
Run the minimal-update target to update the MobileFirst Data Proxy and the
MobileFirst OAuth Trust Association Interceptor (TAI). On WebSphere Application
Server Network Deployment, the TAI needs to be updated manually on every
server.

Procedure
1. Use the Ant files that are used at the initial installation. This way, you are

certain to have the same parameters as the initial installation.
a. Open the Ant file and verify the value of the worklight.server.install.dir

property.
Make sure that worklight.server.install.dir points to the installation of
the product that contains the interim fix. The Ant tasks update the
application server with the WAR files and JAR files that are found in this
installation directory. If the property points to an installation without the
interim fix, the update to the application server is not to the right level. To
verify that the product installation directory contains the interim fix, open
product_install_dir/README.html. This file contains the build number. For

Updating the application server 3-9



example, if interim fix IFIX 7.1.0.0-IF201510051721 is installed, the build
number in the README.html file must contain this line: Build number: IMF
00-20151005-1721.

b. Verify the passwords.
The Ant file might contain ************ as value for the passwords. You
need exactly 12 stars (************) if you want the password to be
prompted interactively (such as during the deployment on WebSphere
Application Server).
If the value is defined in the Ant file, verify that the passwords are still up
to date.

2. Run the minimal-update target to update MobileFirst Data Proxy. For example,
product_install_dir/shortcuts/ant -f your_ant_file.xml minimal-update

This minimal-update target updates the MobileFirst Data Proxy WAR files. On
Apache Tomcat, WebSphere Application Server Liberty profile, and stand-alone
WebSphere Application Server, it updates the TAI. However, on WebSphere
Application Server Network Deployment, the TAI needs to be updated
manually.

3. For WebSphere Application Server Network Deployment, replace the
com.ibm.worklight.oauth.tai_*.jar file with the new version on all nodes of
your WebSphere Application Server cell. This JAR file can be found in
product_install_dir/WorklightServer/external-server-libraries folder. For
more information, see install the MobileFirst Data Proxy manually.

4. Restart the application server for these updates to take effect.

Note: It is needed to restart the application servers for WebSphere Application
Server Network Deployment since the TAI is modified.

Applying the fix pack manually
Procedure
1. Locate the MobileFirst Data Proxy WAR file. This imf-data-proxy.war file is in

product_install_dir/Datastore folder.
2. Replace the imf-data-proxy.war file in your application server.
3. Stop the application server.
4. Locate the TAI JAR file. This com.ibm.worklight.oauth.tai_*.jar file is in

product_install_dir/WorklightServer/external-server-libraries folder.
5. Replace the TAI JAR file in your application server.
6. Optional: On WebSphere Application Server Liberty profile, replace the TAI

feature manifest in your application server.
The OAuthTai-1.0.mf manifest file can be found in product_install_dir/
WorklightServer/external-server-libraries folder.

7. Restart the application server for these updates to take effect.
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Support and comments

For the entire IBM MobileFirst Platform documentation set, training material and
online forums where you can post questions, see the IBM® website at:

http://www.ibm.com/mobile-docs

Support

Software Subscription and Support (also referred to as Software Maintenance) is
included with licenses purchased through Passport Advantage® and Passport
Advantage Express. For additional information about the International Passport
Advantage Agreement and the IBM International Passport Advantage Express
Agreement, visit the Passport Advantage website at:

http://www.ibm.com/software/passportadvantage

If you have a Software Subscription and Support in effect, IBM provides you
assistance for your routine, short duration installation and usage (how-to)
questions, and code-related questions. For additional details, consult your IBM
Software Support Handbook at:

http://www.ibm.com/support/handbook

Comments

We appreciate your comments about this publication. Please comment on specific
errors or omissions, accuracy, organization, subject matter, or completeness of this
document. The comments you send should pertain to only the information in this
manual or product and the way in which the information is presented.

For technical questions and information about products and prices, please contact
your IBM branch office, your IBM business partner, or your authorized remarketer.

When you send comments to IBM, you grant IBM a nonexclusive right to use or
distribute your comments in any way it believes appropriate without incurring any
obligation to you. IBM or any other organizations will only use the personal
information that you supply to contact you about the issues that you state.

Thank you for your support.

If you would like a response from IBM, please provide the following information:
v Name
v Address
v Company or Organization
v Phone No.
v Email address
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Notices

This information was developed for products and services offered in the US. This
material might be available from IBM in other languages. However, you may be
required to own a copy of the product or product version in that language in order
to access it.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive, MD-NC119
Armonk, NY 10504-1785
US

For license inquiries regarding double-byte character set (DBCS) information,
contact the IBM Intellectual Property Department in your country or send
inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some jurisdictions do not allow disclaimer of
express or implied warranties in certain transactions, therefore, this statement may
not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM websites are provided for
convenience only and do not in any manner serve as an endorsement of those
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websites. The materials at those websites are not part of the materials for this IBM
product and use of those websites is at your own risk.

IBM may use or distribute any of the information you provide in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Director of Licensing
IBM Corporation
North Castle Drive, MD-NC119
Armonk, NY 10504-1785
US

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

The performance data and client examples cited are presented for illustrative
purposes only. Actual performance results may vary depending on specific
configurations and operating conditions.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to actual people or business enterprises is entirely
coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.
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Each copy or any portion of these sample programs or any derivative work must include a copyright notice as follows:
© (your company name) (year).
Portions of this code are derived from IBM Corp. Sample Programs.
© Copyright IBM Corp. _enter the year or years_.

Trademarks
IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the web at "Copyright and
trademark information" at www.ibm.com/legal/copytrade.shtml.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States,
and/or other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Node.js is a trademark of Joyent, Inc. and is used with its permission. This
documentation is not formally endorsed by or affiliated with Joyent.

Other company products or service names may be trademarks or service marks of
others.

This document may not be reproduced in whole or in part without the prior
written permission of IBM.

Terms and conditions for product documentation
Permissions for the use of these publications are granted subject to the following
terms and conditions.

Applicability

These terms and conditions are in addition to any terms of use for the IBM
website.

Personal use

You may reproduce these publications for your personal, noncommercial use
provided that all proprietary notices are preserved. You may not distribute, display
or make derivative work of these publications, or any portion thereof, without the
express consent of IBM.
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Commercial use

You may reproduce, distribute and display these publications solely within your
enterprise provided that all proprietary notices are preserved. You may not make
derivative works of these publications, or reproduce, distribute or display these
publications or any portion thereof outside your enterprise, without the express
consent of IBM.

Rights

Except as expressly granted in this permission, no other permissions, licenses or
rights are granted, either express or implied, to the publications or any
information, data, software or other intellectual property contained therein.

IBM reserves the right to withdraw the permissions granted herein whenever, in its
discretion, the use of the publications is detrimental to its interest or, as
determined by IBM, the above instructions are not being properly followed.

You may not download, export or re-export this information except in full
compliance with all applicable laws and regulations, including all United States
export laws and regulations.

IBM MAKES NO GUARANTEE ABOUT THE CONTENT OF THESE
PUBLICATIONS. THE PUBLICATIONS ARE PROVIDED "AS-IS" AND WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING
BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY,
NON-INFRINGEMENT, AND FITNESS FOR A PARTICULAR PURPOSE.

IBM Online Privacy Statement
IBM Software products, including software as a service solutions, (“Software
Offerings”) may use cookies or other technologies to collect product usage
information, to help improve the end user experience, to tailor interactions with
the end user or for other purposes. In many cases no personally identifiable
information is collected by the Software Offerings. Some of our Software Offerings
can help enable you to collect personally identifiable information. If this Software
Offering uses cookies to collect personally identifiable information, specific
information about this offering’s use of cookies is set forth below.

Depending upon the configurations deployed, this Software Offering may use
session cookies that collect session information (generated by the application
server). These cookies contain no personally identifiable information and are
required for session management. Additionally, persistent cookies may be
randomly generated to recognize and manage anonymous users. These cookies
also contain no personally identifiable information and are required.

If the configurations deployed for this Software Offering provide you as customer
the ability to collect personally identifiable information from end users via cookies
and other technologies, you should seek your own legal advice about any laws
applicable to such data collection, including any requirements for notice and
consent. For more information about the use of various technologies, including
cookies, for these purposes, see IBM’s Privacy Policy at http://www.ibm.com/
privacy and IBM’s Online Privacy Statement at http://www.ibm.com/privacy/
details the section entitled “Cookies, Web Beacons and Other Technologies” and
the “IBM Software Products and Software-as-a-Service Privacy Statement” at
http://www.ibm.com/software/info/product-privacy.
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